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1. Généralité 
LuxsarRemote CMS (Système de supervision central) offre une complète 
interface pour une solution centrale de visualisation des équipements de vidéo 
surveillance. 
 
Il donne à l’utilisateur la possibilité de visualiser les images en provenance de 
multiple enregistreurs simultanément. Le nombre maximal de sites connectés 
est de 64 et le nombre de groupes est de 10. 
 

Enregistreur 1

Enregistreur 2
Enregistreur 3

LuxsarRemote CMS

Dôme IP

Dôme analogique
Caméra IP

Vidéo serveur

Réseau

Câble BNC

 
 
Caractéristiques : 

 Visualisation multi-sites – Supporte 10 groupes et chaque groupe 
peuvent être composé de 64 sites. 

 Fonction alerte (Seulement sur LAN) – Envoi la vidéo direct, des 
évènements et des messages à l’ordinateur distant. 

 Configuration distante- Configure les paramètres de l’enregistreur 
distant. 

 Lecture distante – Permet à l’utilisateur de visualiser les images 
enregistrées dans l’appareil distant. 

 Information disque dur – Affiche toutes les informations concernant les 
disques durs qui sont utilisé sur l’ordinateur local. 

 Contrôle de dôme – Contrôle de dôme au travers du réseau. 
 Recherche (Appareil) – Recherche sur le réseau les enregistreurs 

disponible. 
 Recherche (Evènement) – Recherche sur le réseau les évènements 

enregistrés. 
 Enregistre – Enregistre les images directes ou enregistrées sur 

l’ordinateur local. 
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2. Installation du logiciel 
Après avoir obtenu le fichier d’installation, suivre les étapes suivantes pour 
installer LuxsarRemote CMS sur l’ordinateur local. 
Etape 1 : Double-cliquer sur le fichier zip pour le 

décomprésser. 
 
Etape 2 : Après avoir décomprésé le fichier cliquer 

sur CMS_Setup_ v*.*.****(version #).exe 
pour lancer l’installation. 

 
NOTE : Si une précédante version de LuxsarRemote CMS a été 
installée sur l’ordinateur local, un message s’affichera durant 

l’installation. 
 

 

 
Si vous souhaitez exporter la configuration précédante, veuillez cliquer sur 
<Cancel> pour quitter l’installation. Puis, lire le chapitre Export ou de l’Import de 
la configuration pour connaitre la procedure de l’importantion et l’exportation de 
la configuration. Après l’exportation, relancer l’installation de LuxsarRemote 
CMS. Après avoir cliqué sur <OK> dans la boîte de message, une fenêtre d’aide 
d’affichera. Cliquer sur <Uninstall> pour déinstaller l’ancier LuxsarRemote CMS, 
et continuer avec les étapes suivantes. Lorsque vous aurez fini l’installation, 
importer la configuration de LuxsarRemote CMS, ainsi votre LuxsarRemote 
CMS aura la même configuration que la version précédante. 
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Si vous avez installé une ancienne version de LuxsarRemote CMS, après avoir 
cliqué sur <Ok>, une <Confirmation de déinstallation> window sera affichée, 
cliquer sur <Uninstall> pour déinstaller l’ancienne version et continuer sur les 
étapes suivante. 

 
 
Etape 3 : Sélectionner les composants que vous souhaitez installer. Il est 

vivement recommendé de sélectionner <Start Menu Shortcuts> 
(Racourci de démarrage) pour créer un raccourci dans le menu de 
démarrage et sur le bureau, ou bien vous devrez lancer le programme 
en suivant le chemin «C:\Program Files\CMS\EXE\ CMS.exe». 
Cliquer sur <Next> (suivant) pour aller à l’étape suivante. 

 

 
 
Les composants de l’installation LuxsarRemote CMS sont : 

: Le programme principal LuxsarRemote CMS (Défaut). 
: A valider pour installer LuxsarRemote CMS. 
: A valider pour installer le service NTP (Network Time Protocol). 

: A valider pour créer des raccourcis dans le menu de démarage. 
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Etape 4 : Le programme principal LuxsarRemote CMS sera le 1er à étre 
installé. Vous pouvez choisir le dossier ou installer LuxsarRemote 
CMS ou il sera installé à sa destination par défaut «C:\Program 
Files\CMS\». Cliquer sur <Install> (Installer) pour lancer l’installation 
ou cliquer sur <Back> (Précédent) pour revenir à l’étape précédente. 

 

 
 

Etape 7 : Le service NTP (Serveur) sera le troisième programme à être installé. 
Le service NTP (Serveur) permet à l’ordinateur locale sur lequel 
fonctionne LuxsarRemote CMS de devenir le serveur centrale NTP 
pour tout les enregistreurs ainsi l’heure des enregistreurs distant et 
l’heure de l’ordinateur local seront synchronisé. 
Cliquer sur <OK> (OUI) pour aller à l’étape suivante. 

 

 
 
Etape 8 : Cliquer sur <Yes> (Oui) pour lancer l’installation du service NTP, le 

programme est appelé «AboutTime MSIE», et continuer pour terminer 
l’installation complète du service NTP. 
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Etape 9 : Cliquer sur <Close> (Fermer) et l’installation du logiciel sera terminée. 
 

 
 
Sevice NTP (Serveur) 
Le service NTP (Serveur) permet à l’ordinateur local sur lequel à été installé 
LuxsarRemote CMS de devenir le serveur central NTP pour les enregistreurs 
distants ainsi l’heure pour les enregistreurs et l’heure pour l’ordinateur local 
seront synchronisé. 
 
Pour faire cela, vous aurez besoin de trouver l’adresse IP de l’ordinateur local. 
 
Aller dans le menu Démarrer, sélectionner Exécuter. 
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Saisir cmd et cliquer sur OK. 
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Saisir ipconfig pour obtenir l’adresse IP de votre ordinateur. Ecrire l’adresse IP 
sur un papier pour l’utiliser ultérieurement. 

 
Après avoir trouvé l’adresse IP, entrer dans le <Main Menu> (Menu principal) de 
l’enregistreur ou des enregistreurs distants. 
 
En premier, aller dans <Main Menu> (Menu principal)  <System Setup> 
(Configuration système)  <Time Zone> (Fuseau horaire) pour entrer dans le 
menu de configuration du fuseau horaire. Sélectionner <Time Zone> pour entrer 
le fuseau horaire. Pour trouver votre fuseau horaire local, veuillez visiter 
wwp.greenwichmeantime.com 
 

NOTE : Le <Time Zone> (Fuseau horaire) doit-être configuré comme 
étant votre fuseau horaire local ou bien le menu <Network Time Protocol 

Setup> (Configuration synchronisation horaire) ne sera pas accessible. 
Après avoir configuré le fuseau horaire, l’option <Network Time Protocol Setup> 
(Configuration synchronisation horaire) apparaitera. Aller dans <Main Menu> 
(Menu principal)  <System Setup> (Menu système)  <Network Time Protocol 
Setup> (Configuration synchronisation horaire) et suivre le menu qui sera 
affiché. 
 
 
 
 
 
Dans cet exemple, le serveur NTP doit-être configuré avec l’adresse 
92.168.7.122 qui est l’adresse IP de l’ordinateur local. Après que l’heure du 
serveur ai été configurée, sélectionner <Manually Time Sync> (Synchronisation 
de l’heure manuel) pour synchroniser l’heure avec votre ordinateur local. L’heure 
peut aussi être synchronisée periodiquement. Sélectionner alors <Automatically 
Time Sync> (Synchronisation horaire automatique) et choisir la période 
souhaitée pour la synchronisation. 

Network Time Protocol Setup 
1. NTP server time.nist.gov 
2. Automatically Time Synch 1 hour 
3. Manually Time Sync No 

Configuration synchronisation horaire 
1. Serveur NTP time.nist.gov 
2. Synch. horaire auto. 1 heure 
3. Synch. horaire manuel Non 
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3. Lancer le logiciel LuxsarRemote CMS 
Il y a trois façons de lancer le logiciel LuxsarRemote CMS : 
 
Methode A : Cliquer sur <Démarrer> et sélectionner <Programme>, chercher 

«CMS» dans la liste de programme et cliquer dessus. 

Methode B : Double cliquer sur le racourci  sur votre bureau. Cela est 

possible uniquement pour ceux qui on validé l’option «Raccourci» 
durant l’installation. Veuillez parcourir le chapitre «Installation du 
logiciel» pour plus d’information. 

 
Methode C : Aller à «C:\Program Files\CMS\EXE\» et double cliquer sur 

l’icone . 

4.  Touche disponible sur la fenêtre principale 
Après avoir lancé LuxsarRemote CMS, la fenêtre principale de LuxsarRemote 
CMS sera affichée comme le montre la figure ci-dessous. Il y a plusieurs 
touches positionnées sur le haut de la fenêtre principale. Le nom de chaque 
touche est donné ci-dessous. 

Direct Lecture LuxasrPlayer Photo E-Map Enregistrement Configuration

Bandepassante
& audio

Modes
d'affichage

Info
disques durs
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L’utilisation et la fonction de chaque touche est brièvement decrite dans les 
paragraphes suivant. 
 
Direct 
Cliquer sur cette touche pour visualiser le vidéo en directe, la fenêtre en haut à 
gauche montre le site sur lequel vous êtes connecté. 
 
Noté qu’après avoir visualisé la vidéo enregistrée, vous devez cliquer sur cette 
touche pour revenir sur la visualisation des images en direct, toutefois affichera 
la dernière image enregistrée. 
 
LECTURE 
Cliquer sur cette touche pour visualiser la vidéo enregistrée sur le disque dur de 
l’enregsitreur distant. Veuillez-vous référer à la section <Lecture de la vidéo 
enregistrée> pour plus d’information au sujet de la lecture de la vidéo 
enregistrée. 
 
LUXSAR PLAYER 
Cliquer sur cette touche pour ouvrir LuxsarPlayer. LuxsarPlayer est une 
version compacte de la version standard de l’enregistreur. 
 
PHOTO 
Cliquer sur cette touche pour sauvegarder l’image courante. Référez-vous au 
chapitre <Prendre une photo> pour plus d’information. 
 
E-MAP 
Cliquer sur cette touche pour ouvrir le programme E-MAP. E-Map est un 
programme qui permet à l’utilisateur d’illuster la possition des caméras sur une 
image qu’il aura créée lui-même. 
 
ENREGISTREMENT 
Cette touche permet à l’utilisateur de planifier l’enregistrement. 
 
CONFIGURATION 
Cliquer sur cette touche pour assigner les caméras et configurer les sites et 
groupes. Référez-vous à la section <Configurer votre CMS> pour plus 
d’information. 
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Site en cour de visualisation 
Affiche le site que vous êtes atuellement entrain 
de visualiser. Si la connection de certaine caméra 
est en défaut, alors aucune image ne sera 
affichée sur l’emplacement assigné à cette 
caméra. Faîte un clique «droit» sur le «Site» et 
un menu sera affiché. Cliquer sur Reconnecter 
et LuxsarRemote CMS tentera de reconnecter 
toutes les caméras de tout les sites. 
 
 
 
Bande passante & Audio 
Cliquer ici pour choisir les options de la bande passante. Choisir <High> (Haute) 
lorsque la bande passante internet est grande et <Low> (Basse) lorsqu’elle est 
faible. 
 
A la suite des options de bande passante se trouve la touche audio, cliquer sur 
cette touche pour activer ou désactiver l’audio. 
 

 

NOTE : Que cette fonction soit sur ON ou OFF, l’audio continura à être 
enregistré sur l’enregistreur distant. 

 
Modes d’affichage 
Cliquer sur une de ces touches pour visualiser les 
images en mode mosaïque. Vous pouvez 
sélectionner une mosaïque de 4, 9, 16, 25, 36, 49, ou 
64 images. 
 
 

 



Manuel d’utilisation   

 
12 

Information disque dur 
La figure circulaire en bas à gauche affiche les 
informations concernant le disque dur. Cela est 
particulièrement pratique lorsque l’utilisateur utilise 
LuxsarRemote CMS pour enregistrer la vidéo sur 
l’ordinateur local. 
 
En faisant dérouler le menu, vous pouvez voir tous 
les unitées de disque que votre ordinateur utilise 
telque l’unité C, l’unité D…, etc. La couleur bleu de la 
figure indique l’espace utilisé et la couleur jaune 
indique l’espace disponible. 
 

5. Configurer votre LuxsarRemote CMS 
LuxsarRemote CMS accepte la gestion de 10 groupes et 64 sites peuvent être 
ajoutés à chaque groupe. Par exemple, vous pouvez configurer 2 groupes pour 
l’enregistrement journalier et le reste pour l’enregistrement de nuit. La section 
suivante vous guide pour configurer votre LuxsarRemote CMS étape par étape. 

Cliquer sur le touche  sur le haut de la fenêtre principale et l’écran 

ci-dessous apparaitera. 
 

Ajouter un
groupe

Effacer un
groupe

Ajouter un
site

Effacer un
site Déployer Réduire
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5.1 Configuration des Groupes 
10 groupes peuvent être configurés avec LuxsarRemote CMS. Cette section 
guidera l’utilisateur pour configurer ou effacer un groupe et aussi pour montrer à 
l’utilisateur comment «Démarrer un groupe». 
 
Ajouter un groupe 

Cliquer sur la touche  pour ajouter un groupe. Double cliquer sur le groupe 

ou le site pour lui donner un nom en saisissant directement le nom au clavier. 
 

 
 
L’autre solution pour ajouter un groupe est de faire un clique droit sur <Groups> 
(Groupe) et de sélectionner <Add a group> (Ajouter un groupe). 
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Configurer le démarrage d’un groupe 
Le «Groupe de démarrage» est le groupe qui sera automatiquement vue lors du 
lancement de LuxsarRemote CMS. 
 
Faire un clique droit sur le groupe que vous voulez définir comme le «Groupe de 
démarrage» et sélectionner <Set as start group> (Configurer comme groupe de 
démarrage) à partir du menu surgissant. 
 

 
 

NOTE : Si un groupe est configuré comme un «Groupe de démarrage», 
L’icône du groupe sera changé pour marquer la différence. 
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Déployer/Réduire un groupe 
Il y a deux façons de déployer ou de réduire un groupe. Le premier consiste à 

utiliser les deux touches . L’autre consiste à faire un clique droit avec la 

souris sur le groupe et de sélectionner <Expand> (Déployer) ou (Réduire) dans 
le menu surgissant. 
 

 
 
Effacer un groupe 
Pour effacer un groupe, cliquer sur le groupe que vous souhaitez effacer, puis 

cliquer directement sur la touche  pour effacer le groupe chosie. 
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L’autre façon est de faire un clique droit sur <Groups> (Groupes), alors un menu 
surgissant apparait, sélectionner <Remove all groups> (Effacer tous les groupes) 
dans le menu surgissant. Notez que dans ce cas vous effacerez tous les 
groupes ; si vous ne souhaitez pas tous les effacer, ne choisissez pas cette 
option. 
 

 
 

5.2 Gestion des sites 
Ce paragraphe vous guidera dans la structure des groupes et des sites. 
 

5.2.1 Ajouter/Effacer un site 
Il est possible d’ajouter jusqu’à 64 sites dans chaque groupe. Ce paragraphe 
vous guidera pour ajouter et effacer un site. Les prcédures pour ajouter et 
effacer un groupe sont les mêmes. 
 
Ajouter un site 
Choisir un groupe dans lequel vous voulez ajouter site. Après l’avoir choisi, 

cliquer sur la touche  pour ajouter un siteà ce groupe. La section suivante 

vous guidera pour configurer le site pas à pas. 
 
Double cliquer sur le groupe ou le site pour lui donner un nom, et saisissez le 
directement avec le clavier. 
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L’autre façon d’ajouter un site à un groupe est de faire un clique droit sur le 
groupe et de sélectionner <Add a site> (Ajouter un site) pour ajouter un site. 
 

 
 
Effacer un site 
Pour effacer un site, cliquer sur le site que vous souhaitez effacer puis cliquer 

disrectement sur la touche  pour effacer le site choisi. 
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L’autre façon est de cliquer sur le site, un menu surgissant apparait, 
sélectiuonner <Remove> (Effacer) dans le menu surgissant. 
 

 
 
Le paragraphe suivant vous guidera pour configurer le site que vous avez 
ajouté. 
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5.2.2 Configurer le site 
Un site réprésente un enregistreur distant, et le nombre de site est égal au 
nombre d’enregistreur. 
 
Il y a deux façons de configurer un enregistreur distant comme un «site» sur le 
LuxsarRemote CMS. 
 
Methode A: Configurer le site automatiquement 
LuxsarRemote CMS est capable de rechercher les adresses IP des 
enregistreurs qui sont connectés sur le réseau LAN. 
 
Etape 1 : Si vous avez configurez un 

réseau LAN, LuxsarRemote 
CMS peut rechercher sur le 
réseau LAN les adresses IP 
des stockeurs qui sont 
disponible sur le réseau LAN. 
Cliquer sur l’icône recherche 
(sous le menu configuration) 
pour ouvrir la fenêtre de 
recherche. 

 
Etape 2 : Cliquer <Refresh> (Rafraichir) 

pour rechercher les adresses 
IP des enregistreurs 
connectés sur le réseau LAN. 
Sélectionner un enregistreur 
dans la liste des adresses IP 
et doucle cliquer sur 
l’enregistreur IP que vous 
souhaitez ajouter au site. 
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NOTE : La fonction recherche peut-être utilisé pour rechercher les 
adresses IP des stockeurs connectés surt le réseau LAN. Par exemple, 

si votre ordinateur utilise l’adresse IP 192.168.1.5 et qu’un enregistreur à 
l’adresse IP 192.168.1.7, LuxsarRemote CMS sera capable de trouver 
l’adresse IP de l’enregistreur. Cependant, s’il y a un autre enregistreur connecté 
sur un autre réseau LAN ayant une adresse telque 192.168.3.6, LuxsarRemote 
CMS (qui a l’adresse 192.168.1.5) ne sera pas capable de trouver l’adresse IP. 
 
Methode B: Configurer le site manuellement 
Si vous connaissez les informations détailées de la configuration réseau 
(adresse IP, port, nom utilisateur et mot de passe) de votre enregistreur, vous 
pouvez configurer manuellement le site. 
Saisir le nom du site, l’adresse IP, le port, le nom utilisateur et le mot de passe. 
Cliquer sur <OK> pour terminer la configuration. 

 

 
Ou si vous avez les informations DDNS de l’enregistreur distant, vous pouvez 
choisir de saisir les informations DDNS. Valider l’option <(D)DNS> encerclé 
ci-dessous et saisir les informations DDNS. Cliquer <OK> pour terminer la 
configuration. Exemple d’adresse DDNS : 
Exemple_0040d1.ddns.iview-ddns.com 
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NOTE : Le numéro du port n’est nécessaire dans le mode de 
fonctionnement DDNS. Donc, si la fonction (D)DNS a été validée, vous 

n’avez pas à changer le numéro de port.  
 

5.3  Configuration des dossiers de stockage 
Le menu des dossiers de stockage vous permet de défénir les destinations de 
stockage pour ; les photos instantanées, vidéo enregistrée et fichier d’archive. Il 
est recommandé d’utiliser les dossiers par défaut. 
 
La fonction <Circular> (Circulaire) est utilisée pour ajuster l’espace disque utilisé 
par LuxsarRemote CMS. Par exemple, Lorsque le seuil est configuré à 1Go et 
qu’il y a 20 Go d’espace disque libre sur le disque dur. LuxsarRemote CMS ne 
peut avoir accès à plus de 19 Go. Aussi longtemps que l’espace disque libre est 
plus petit que le seuil, LuxsarRemote CMS ecrasera les données les plus 
anciennes. 
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Format photo instantanée 
LuxsarRemote CMS a une fonction photo instantané et cette fonction est 
configurable ici. Noter que si vous validez plus d’un type de format, par exemple 
2, alors vous verez que chaque photo instatanée a été sauvegardée dans les 
deux types de format. 
 

5.4  Alerte 
La fonction alerte est utilisée pour envoyer un signal d’alerte à LuxsarRemote 
CMS au travers du réseau LAN. Ce chapitre descrit comment configurer la 
fonction alerte. 
 
Etape 1 : Trouver l’adresse IP de l’ordinateur sur lequel est installé 

LuxsarRemote CMS. 
 

Allez dans le menu Start (Démarrer) et sélectionner Run (Exécuter). 

 
 

Saisir cmd et cliquer sur OK. 

 



  User’s Manual 

 
23

Saisir ipconfig pour obtenir l’adresse IP de l’ordinateur local. 
Mémoriser l’adresse IP pour l’utiliser plus tard. 

 
 
Etape 2 : Configurer la notification d’alerte sur l’enregistreur distant. 

Cette fonction permettera à l’enregistreur d’envoyer la notification 
d’alerte à LuxsarRemote CMS. Entrer dans le menu de l’enregistreur 
et aller dans le menu de configuration de notification d’alerte sous 
<Configuration évènements>. 

 
 
 
 
 

Configuration alerte 
Configuration alerte permet de mémoriser trois combinaisons de 
configuration de notifictaion d’alerte. 
 
Notification d’alerte 
4 options sont incluse dans cette option, OFF (Non), Event 
(Evènements), Alive (Activité) et Both (Les deux). 
 
<OFF> : La notification d’alerte n’est pas activé. 

 
<Event> : Lorsque une alarme survient, l’enregistreur distant envoi 

un message d’alerte à LuxsarRemote CMS. 

Config. Notification alerte
1. Configuration alerte 1
2. Notification alerte Les deux
3. IP alerte 192.168.7.122
4. Port alerte 9999
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<Alive> : L’enregistreur distant envera un message d’activité à 
LuxsarRemote CMS toutes les deux minutes pour 
montrer que la connexion entre l’enregistreur et 
LuxsarRemote CMS est bien effective. 

 
<Both> : Cette option permet à l’enregistreur distant d’envoyer les 

messages d’alerte ainsi que les messages d’activité à 
LuxsarRemote CMS. 

 
IP alerte 
L’IP alerte doit être l’adresse de l’ordinateur ou LuxsarRemote CMS 
à été installé. Dans cet exemple l’adresse IP de l’ordinateur est 
192.168.7.122 
 
Port alerte  
Le port alerte est le port utilisé pour envoyer et recevoir les messages 
d’alerte. Choisir un port qui est disponible sur votre réseau. Les ports 
de l’enregistreur et de LuxsarRemote CMS doivent être les même, le 
port configurer est 9999. 

 
Etape 3: Configurer l’option alerte de LuxsarRemote CMS. 

Cliquer sur la touche  positionnée sur le haut de la fenêtre 

principale LuxsarRemote CMS et cliquer sur l’onglet «Alert» (Alerte) 
pour configurer le port. Le port 9999 est utilisé dans cet exemple. 
Sélectionner ON (Oui) pour valider la fonction alerte et cliquer sur OK. 
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Etape 4 : Actions d’alerte 
L’enregistreur distant envoi 4 types de message d’alerte à 
LuxsarRemote CMS. «Alive» (Activité), «Alarm» (Alarme), «Motion» 
(Mouvement) et «Video Loss» (Pèrte vidéo). Le message d’activité 
est envoyé lorsque vous sélectionnez l’option «Alive» (Activité) ou 
«Both» (Les deux) dans l’enregistreur distant. Les messages «Alarm» 
(Alarme), «Motion» (Mouvement) et «Video Loss» (Pèrte vidéo) sonr 
envoyés lorsque vous sélectionnez l’option de notification «Event» 
(Evènement) ou «Both» (Les deux) dans l’enregistreur distant. 

 

Si vous ouvrez LuxsarRemote CMS sans cliquer sur la touche  

pour effectuer la connexion et que vous double cliquez sur message 
évènement (Alarme, Mouvement, Pèrte vidéo), un message 
apparaitera pour vous rappeller de vous connecter en premier. 
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Supposons que vous avez configuré la fonction alerte pour un site 
dans le Groupe 1, mais que vous êtes connecté au groupe 2 et 3. Lorsque 
vous cliquerez sur messages évènement, Une fenêtre sera affichée pour 
vous informer qu’actuellement vous n’êtes pas dans le groupe qui envoie les 
messages d’alerte à LuxsarRemote CMS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Lorsque vous êtes dans le groupe 1 et que vous avez configuré la fonction 
alerte pour le groupe 1. Double cliquer sur les messages d’alerte (Alarme, 
Mouvement ou pèrte vidéo) et LuxsarRemote CMS lira en plein écran la 
vidéo du canal en alerte. 
 

NOTE : La fonction alerte fonctionne uniquement sur un 
réseau LAN. (Veuillez vous référer à la note de la fonction 

recherche) 
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5.5  Export et import des configurations 
La fonction import et export permet à l’utilisateur d’effectuer une sauvegarde des 
configurations lorsqu’il le désire. 
 
Pour exporter la configuration, cliquer sur le <Export> (Exporter) et sélectionner 
un dossier pour sauvegarder le fichier *.zip. 
 
Pour importer la configuration précédante, cliquer sur <Import> (Importer) et 
rechercher le fichier *.zip que vous avez précédement sauvegardé. 
 

NOTE : Si vous souhaitez installer une nouvelle version, rappelez-vous 
d’exporter la configuration. Si non, la configuration de l’ancienne version 

sera effacée et vous deverez reconfigurer le logiciel. Pour cela veuillez vous 
référez au chapitre <Installation du logiciel>. 
 

NOTE : Après le redémarrage de LuxsarRemote CMS, la configuration 
sera changé. 

 

6. Fonctions élémentaires 
Le chapitre suivant vous présente les fonctions élémentaires de LuxsarRemote 
CMS présente dans la fénêtre principale. 
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6.1 Voir les images en directe et assigner une caméra 
L’utilisateur peut voir la vidéo en direct en se connectant à l’enregistreur distant 

en utilisant la touche <Live> (Directe) . 

Si la connection entre LuxsarRemote CMS et 
l’enregistreur à été déconnecté, vous pouvez alors 
vous reconnecter en faisant un clique droit sur le site 
et en sélectionnant <Live> (Directe) dans le menu 
surgisant 
 
 
 
LuxsarRemote CMS vous permet d’assigner un canal vidéo à un emplacement 
sur la grille de la fenêtre principale de LuxsarRemote CMS. 
 
Pour assigner un canal vidéo à une certaine fenêtre 
Etape 1 : Cliquer et maintenir appuyé le canal que vous souhaitez placer sur la 

grille. 
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Etape 2 : Faites glisser la caméra sur la fenêtre ou vous souhaitez la placer. 

 
 
Etape 3 : Faire un clique droit sur un canal et sélectionner <Refresh> (Refresh) 

pour retourner à la vue original. 
 

 

 
 
Etape 4 : Le mode direct revient à la configuration originale après le 

rafraichissement. 
 
Assigner toutes les caméras d’un site à la grille 
Etape 1 : Cliquer et maintenir appuyé le site que vous souhiatez placer. 
Etape 2 : Faire glisser le site sur la grille. 
Etape 3 : Faire un clique droit pour réfraichir la fenêtre. 
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6.2 Relir les clips vidéo enregistrées 
Cette fonction permet à l’utilisateur de relire à distance les clips vidéo 

enregistrés en utilisant LuxsarRemote CMS. Cliquer sur la touche  et la 

fenêtre ci-dessous sera affichée. 
 
Temps valide indique l’heure du début de l’enregistrement et l’heure de fin 
d’enregistrement. 

 
 
Relire la vidéo enregistrée sur le disque dure de l’enregistreur distant 
Pour lire la vidéo enregistrée sur le disque dur de l’enregistreur distant, veuillez 
suivre les étapes suivantes. 
 
Etape 1 : Pour lire la vidéo enregsitrée sur l’appareil distant, cliquer sur l’option 

<Playback> (Lecture). 

 

Etape 2: Spécifier la plage horaire que vous souhitez relire et cliquer sur <OK> 
pour lancer la lecture. 

 



  User’s Manual 

 
31

L’autre façon pour relir la vidéo est de faire un clique droit sur le groupe souhaité 
et sélectionner <Playback> (Lecture) <Remote Playback> (Lecture distante) 
dans le menu surgissant. 

 
 
Sauvegarder les fichier *.drv sur votre ordinateur local 
Pour sauvegarder la vidéo sur l’ordinateur local, veuillez suivre les étapes 
suivantes. 
 
Etape 1 : Si vous souhaitez sauvegarder les fichiers *.drv sur votre ordinateur 

local, choisir l’option <Archive>. 

 

 
Etape 2 : Spécifier l’heure de début et l’heure de fin et cliquer sur <OK> pour 

sauvegarder le fichier de l’enregistreur dans le dossier de destination. 
(Le dossier d’achive par défaut est «C:\Program Files\CMS\Archive») 

 
 
Etape 3 : Après que l’utilisateur ait cliqué sur <OK>, LuxsarRemote CMS 

lancera la lecture de l’archive. Cliquer sur la touche  pour 

revenir au mode direct. 
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Relire la vidéo stockée dans le disque dur de l’enregistreur local 
Il y a deux façons pour relire la vidéo enregistrée sur l’enregistreur local. Noter 
que cela est pour lire la vidéo déjà enregistrée sur l’ordinateur local. 
 
Vous pouvez cliquer <DVR Player> (Lecteur) pour lancer le programme ou 

cliquer sur  le haut de la fenêtre principale de LuxsarRemote CMS. 

 
 
Après avoir cliqué sur <DVR Player> (lecteur), the LuxsarPlayer qui est une 
version compacte du lecteur standard apparait comme le montre la figure 
ci-dessous. 
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Ouvrir le menu surgissant «File» (Fichier) ou cliquer 

sur  pour ouvrir un fichier vidéo. Après avoir 

cliqué sur l’un d’eux, sélectionner le dossier par 
défaut pour lire la vidéo. 
 
Convertir les fichiers *.drv en fichiers *.avi 
La première chose est d’aller à «Select a folder» (Sélectionner un dossier), de 
faire apparaitre le menu «File» (Fichier) et de choisir «Open video file» (Ouvrir 

fichier vidéo) ou de cliquer sur la touche  et la fenêtre «Select a folder» 

surgira. Sur la droite, en haut de la fenêtre, choisir l’option <Convert to AVI> 
(Convertir en AVI). Trouver le fichier *.drv que vous souhaitez convertir en 
«*.avi» et double cliquer dessus. Lorsque vous voyez le message «Convert 
Over» (Convertion terminée), le processuce de convertion est terminé. Le fichier 
sera enregistré dans le dossier «C:\Program Files\CMS\Avi». 
 

  
 
Vitesse de lecture : «0» indique la vitesse la plus lente, «9» est la vitesse 
normale et «20» est la vitesse la plus rapide. 
 

 
 
Pour plus d’information sur les fonctions du lecteur LuxsarPlayer, veuillez vous 
référer à l’appendice. 
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6.3 Configurer l’enregistreur distant 
Le menu contient une liste d’options qui sont utilisées pour configurer 
l’enregistreur distant. 
 
Faîtes un clique droit sur le site et sélectionner «Configuration» pour ouvrir le 
menu de configuration de l’enregsitreur distant. 

 
L’utilisateur peut configurer chaque enregistreur distant qui à été ajouté à 
LuxsarRemote CMS. Par exemple, pour configurer le site 1 du groupe 1, faire 
un clique droit sur un des canaux et choisir «Configuration». Pour configurer le 
site 2 du groupe 1, fire un clique droit sur un des canaux du site 2 et choisir 
«Configuration». 
 
Le menu de configuration est similaire à celui du logiciel de l’enregistreur. 
Veuillez vous référer au manuel de l’enregistreur pour obtenir les informations 
complètes. 
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6.4 Rechercher une vidéo enregistrée 
LuxsarRemote CMS est capable de rechercher et 
relire les clips vidéo enregistrés sur évènement. 
 
Faire un clique droit sur le site et sélectionner 
<Search> (Recherche) et la fenêtre de recherche 
sera affichée. 
 
 
 
 
 
Double cliquer sur un des évènements pour le relire. 
 

NOTE : Seule les enregistreurs présents sur 
le réseau LAN peuvent être recherchés par 

LuxsarRemote CMS. Les adresses IP du LAN 
peuvent être trouvées en utilisant la touche «Search» 
de la configuration. 
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6.5 Prendre une photo instantanée 
La fonction «Snapshot» (Photo) est un simple outil de capture d’écran. Lorsque 

vous cliquez sur la touche , il capturera l’écran avec l’image qui sera 

affichée. Vous pouvez enregistrer les photos d’écran ainsi prisent dans le 
chemin par défaut «C:\ProgramFiles\CMS\Snapshot» ou dans le dossier que vous 
aurez précédement configuré. Veuillez vous référez au chapitre <Setup the File 
Path> (Configurer le chemin des fichiers) pour plus d’information concernant le 
changement des chemins de fichiers. 
 
Il y a deux façons pour prendre une photo d’écran. Le premier est de cliquer sur 
<SNAPSHOT> (Photo Instantanée) et la fenêtre ci-dessous sera affichée. 
Cliquer sur <OK> pour sauvegarder le fichier. 

 
 

Prendre une photo instantanée en utilisant cette façon, vous capturez 
exactement ce que vous êtes entrain de voir sur le moniteur, ce qui signifit que 
lorsque LuxsarRemote CMS est en mode de visualisation 4 images vous 
obtiendrez une photo instantanée ayant 4 images. 
 
L’autre façon est de faire directement un clique «droit» sur l’image que vous 
souhaitez enregistrer. Noter que utilisant cette façon de capturer les images 
vous obtiendrez une image plein écran de ce que vous avez enregistrez. 
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Par exemple, si LuxsarRemote CMS est en mode 4 images et que vous cliquez 
pour prendre une photo instantanée du canal 3, alors vous obtiendrez un photo 
instanténée pein écran et non une photo du mode 4 images. 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE : Lorsque vous utilisez cette méthode pour prendre une photo 
instantanée, vous obtiendrez au moins un image par type de fromat que vous 

avez choisit. Par exemple, si you avez sélectionné Bmp & Tif et que vous prenez 
une photo instantanée, vous obtiendrez deux types fichier d’image de la même 
image. 
 
Veuillez aller à <Settings> (Configuration) pour configurer le type de format 
d’image que vous souhaitez. 
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6.6  Fonction enregistrement 
Pendant que la vidéo est enregistrée dans l’enregistreur distant, l’utilisateur peut 
choisir l’option d’enregistrer la vidéo en directe ou celle enregistrée sur 
l’ordinateur local. 
 
Faire un clique droit sur le site que vous souhaitez 
enregistrer et sélectionner <Start Record> (Lancer 
l’enregistrement) pour lancer l’enregistrement et 
<Stop Record> (Arrêter l’enregistrement) pour arrêter 
l’enregistrement. 
 
 
Lorsque les canaux sont en court d’enregistrement, un «R»  apparait en 
lettre capital dans le titre de la caméra. Si vous n’avez pas changé le chemin du 
fichier, alors le fichier enregistré sera sauvegardé dans le dossier par défaut 
«C:\Program Files\CMS\Record» 
 

NOTE : La fonction enregistrement sauvegardera tous les canaux du 
site en court d’enregistrement. Par exemple, s’il y a 4 sites connectés à 

LuxsarRemote CMS et que l’utilisateur sélectionne un canal du 2eme site à 
enregistrer, LuxsarRemote CMS enregistrera uniquement tous les canaux du 
deuxième site et les site 1,3 et 4 ne seront pas enregistrés. 
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6.7  Fonction plages horaires d’enregistrement 
L’utilisateur peut choisir les plages horaires d’enregistrement de l’ordinateur 
local. La fenêtre des plages horaires d’enregistrement sera affichée en cliquant 

sur la touche  sur le haut de la fenêtre principale de LuxsarRemote CMS. 

 
 
Le menu surgissant cerclé ci-dessous montre les options d’enregistrement. 
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<OFF> (Non) : Arrêt la fonction; plages horaires d’enregistrement. 
<Schedule with Event> (Plage horaires avec évènement): Enregistre la vidéo 
courante sur la plage horaires et tous les évènements. 
<Schedule Only> (Plages horaires uniquement): Enregistre uniquement la vidéo 
sur la plage horaires. 
<Event Only> (Evènements uniquement): Enregistre uniquement les 
évènements. 
 
Le menu surgissant cerclé ci-dessous montre les options de la sélection. 

 
 
<Select Cell> (Sélection cellule) : Sélectionne manuellement une cellule de la 
table. 
<Clear Cell> (Efface cellule) : Efface manuellement le contenue d’une cellule. 
<Select All Cell> (Sélection tous les cellules) : Sélectionne toutes les cellules de 
la table. 
<Clear All Cell> (Efface toutes les cellules) : Efface le contenue de toutes les 
cellules de la table. 
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Ici, vous trouverez l’explication pas à pas de la configuration des plages horaires 
d’enregistrement de votre LuxsarRemote CMS. 
 
Etape 1 : Sélectionner un site ou un canal à partir de la fenêtre sur la gauche 

par un simple clique. Lorsque vous aurez sélectionné un site, tous les 
canaux auront les mêmes plages horaires d’enregistrement. Vous 
pouvez aussi configurer une plage horaire différente pour chaque 
canal. Dans cet exemple, nous choisirons le site. Cliquer sur la 
fenêtre 1 et configurer l’option des plages horaire à <Schedule with 
Event> (Plage horaires et évènement) dans la fenêtre 2. 

 

 
Etape 2 : En supposant que nous souhaitons configurer LuxsarRemote CMS 

pour enregistrer le site de 1:30 AM à 5 AM le mardi et le mercredi. 
Cliquer sur 1:30 ~ 2:00 du mardi et faire glisser sur 4:30 ~ 5:00 du 
mercredi et la couleur des cellules sera changé en vert indicant que 
ces cellules seront enregsitrée come <Schedule with Event> (Plage 
horaire et évènement). 
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Etape 3 : Une fois les plages horaires sélectionnée, cliquer sur <OK> pour 

sauvegarder et quitter le menu de configuration des plages horaires. 
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Si vous voulez retirer une plage horaire du calendier, par exemple 2:30 ~ 3:00 
configurer la cellule sélectionnée à <Clear Cell> (Effacer cellule) dans la fenêtre 
1. Cliquer et faire glisser 2:30 ~ 3:00 de mardi à mercredi. Les cellules vides 
indiquent qu’elles ne seront pas enregistrées. Cliquer sur <OK> pour 
sauvegarder et quitter le menu d’enregistrement sur plage horaire. 

 
 
Si vous voulez configurer le calendrier pour enregistrer en permanance, choisir 
<Select All Cell> (Sélectionner toutes les cellules) ou cliquer sur la cellule vide 
cerclée dans le coin gauche de la table. Si vous souhaitez réinitialiser le 
calendrier du site, sélectionner les cellules et configurez les à <Clear All Cell> 
(Effacer toutes les celluls). Cliquer sur <OK> pour sauvegarder et quitter le 
menu de configuration des plages horaires. 
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Une autre façon de sélectionner ou effacer les plages horaires est de cliquer 
sur le jour ou l’onglet des heures. Par exemple, lorsque vous cliquez sur 
l’onglet <Tuesday> (Mardi), la couleur de la journée de mardi sera changée 
signifiant qu’ils seront enregistrés. Lorsque vous cliquez sur l’onglet 5:00 ~ 
5:30, la couleur de 5:00~5:30 du lundi au dimanche sera changée. Cliquer sur 
<OK> pour sauvegarder et quitter le menu de configuration des plages 
horaires. 
 

 
 

NOTE : Les camréas IP ne support pas cette fonction. 
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6.8 Fonction E-Map 
E-Map est un programme qui permet à l’utilisateur de positionner les caméras 
sur une image ou un plan de sont choix. 
 

Cliquer sur la touche  sur le haut de la fenêtre principale de 
LuxsarRemote CMS pour ouvrir la fenêtre E-Map. La figure ci-dessous est la 
fen^tre principale d’ E-Map. 

 
 
Veuillez suivre la fenêtre ci-dessous pour configurer E-Map. 
 
Etape 1 : Vous devez charger un fichier image dans E-Map. Cliquer sur 

<LOADIMAGE> (Charger une image) pour charger une image. 
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Etape 2 : La figure ci-dessous montre la fenêtre de chargement pour ajouter, 
effacer, retourner en arrière et confirmer une image. Cliquer sur la 
touche <Add> (Ajouter) pour ajouter une image. Noter que E-Map 
supporte uniquement les fichiers ayant le format *.bmp, *.jpg, et *.gif. 
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Etape 3 : Après avoir ajouté une image, le nom du fichier de l’image sera 
affiché dans la fenêtre de chargement d’image. L’index indique l’ordre 
des fichiers. Si vous ajoutez une 2eme image à E-Map, le 2eme index 
sera «1».Une fois l’image chargée, cliquer sur <Ok> pour confirmer. 

 

 
Etape 4 : Sélectionner une des images que vous avez chargé dans E-Map à 

partir de la fenêtre cerclée. 
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Step 5 : L’image choisie sera affichée dans la fenêtre principale de E-Map. 
L’image de l’épicerie ci-dessous est utilisée pour exemple. Cliquer et 
maintenir appuyé un canal dans la fenêtre de gauche. Maintenir et 
faire glisser le canal à un endroit de l’image. 

 

 
Etap 6 : Lorsque vous pointez le curseur sur l’icône de la caméra placé sur 

l’image, une fenêtre d’information sera affiché comme le montre la 
figure ci-dessous. 
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Etape 7 : Double cliquer sur l’icône de la caméra placée sur l’image pour voir 
les images en direct. 

 
 
Il y a 3 types d’icône dans E-Map, dôme, caméra fixe et alerte. 

 Icône dôme.  
 Icône caméra fixe.  
 Icône alerte. 

L’icône dôme sera affiché lorsque la caméra sélectionnée est une caméra 
mobile. L’icône caméra fixe sera affiché lorsque la caméra sélectionnée est une 
caméra fixe. L’icône alerte sera affiché lorsqu’une alarme est déclenchée sur 
une caméra. 
 
Vous pouvez ajuster l’image affichée sur E-Map en cliquant sur les icônes 
cerclés en bleu. 
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<Original> (Original) : Affiche l’image dans sa taille original. 
<Double> (Double) : Doucble la taille de l’image. 
<Half> (Demi) : Réduit l’image de moitié. 
<Fill> (Plein écran) : Ajuste la taille de l’image à la dimension de la fenêtre de 
E-Map (Voir la figure ci-dessous). 
 
Lorsqeu l’image est très large ou lorsque vous ne pouvez pas voir l’image en 
entier, cliquer sur un canal dans la fenêtre cerclé en bleu sur la gauche de 
E-Map et E-Map placera automatiquement la caméra au centre de la fenêtre. 

 



  User’s Manual 

 
51

Appendice : LuxsarPlayer 
LuxsarPlayer est une version compacte du lecteur standard. La fenêtre principale de 
LuxsarPlayer est montrée ci-dessous avec le nom des touches. 

Ouvrir un
fichier vidéo

Photo
instantanée

Configuration
de visualisation

Plein
écran

Au sujet
de

Pause

Lecture

Moins rapide

Plus rapide

Indicateur de vitesse

Barre d'avancement

Arboressance
des site

Mode 
d'affichage

 
 

La fonction de chaque touche est décrite dans les paragraphes ci-dessous. 
 
Ouvrir un fichier vidéo 
Cliquer sur «Ouvrir un fichier vidéo» L’autre façon d’ouvrir un fichier 
vidéo est en cliquant sur la barre de menu fichier comme le montre la 
figure de troite. 
Pour ouvrir un fichier, vous devez 
trouver le fichier *.DRV dans la fenêtre 1 
cerclé en bleu. Une fois le fichier trouvé, 
valider l’option <Play DRV File> (Lire 
fichier DVR) de la fenêtre 2 cerclée en 
bleu. Enfin double cliquer sur le fichier 
de la fenêtre 3 et le fichier sera 
automatiquement lue. Si vous souhaitez 
convertir le fichier *.drv en format *.avi. 
Cliquer sur l’option <Convert To AVI> (Convertir en fichier avi) à coté de la fenêtre 2 
cerclée en bleu et doucle cliquer sur le fichier dans la fenêtre 3 cerclé en bleu. Le chemin 
par défaut est: «C:\Program Files\CMS\Record» 
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Photo instantanée 
Cliquer sur «SNAPSHOT» (Photo instanténée) pour prendre 
une photo instantanée. L’autre façon de prendre une photo 
instantanée est de cliquer dans la barre de menu de contrôle de 
lecture comme le montre la figure de droite. 
 
Après avoir ouvert la fenêtre de 
photo instantanée, vous pouvez 
choisir de renomer le fichier ou de le 
laisser comme cela. Cliquer sur 
<Ok> pour sauvegarder la photo 
instantané ou <Cancel> (Annuler) 
pour quitter. 
 
 
 
Configuration de visualisation 
Cette fonction permet à l’utilisateur de 
montrer ou de cacher l’heure et le texte 
d’alarme sur la vidéo. 
 
Cliquer sur l’icône <Frame View Setting> 
(Configuration visualisation) et la boîte de 
dialogue «PlayerViewSetting» (Configuration 
visualisation) sera affichée. Valider l’option 
<ShowTime> (Afficher l’heure) et l’heure sera 
affichée sur l’écran. Valider l’option <Show 
Frame State> (Afficher texte alarme) et le 
texte de l’alarme telque, détection de 
mouvement ou pèrte vidéo sera affiché sur 
l’acran. Dévalider cette option pour cacher 
ces textes. 
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L’autre façon d’ouvrir cette fonction est de 
cliquer sur «SYSTEM SETTING» 
(Configuration système) dans la barre de 
menu comme indiqué à droite. 
 
 
Full Screen 
Click to change the view to full screen mode. 
The other way is by clicking the View Menu Bar 
as shown in the right. 
 
 
About 
Click to view the LuxsarPlayer version 
information. 
 
 
 
 
 
Pause 
Click to pause the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
 
 
 
 
 
Play 
Click to play the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
 
Speed Down 
Click to speed up the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
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Speed Up 
Click to speed up the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
Site Tree 
The site tree shows the channels of the remote DVR. Double click a channel to view the 
specified channel in one screen. Note the speaker icon located in the bottom. Click it to 
enable or disable the audio. You can also find it under the System Setting Bar. 
 
The site tree shows the channels of the remote DVR. 
Double click a channel to view the specified channel in one 
screen. Note the speaker icon located in the bottom. Click 
it to enable or disable the audio. You can also find it under 
the System Setting Bar. 
 
 
 
 
 
 
Mode Option 
Click any of them to view the image in a multiple window 
mode. You can select from 4-window, 9-window, and 
16-window 
 
 
Speed Indicator 
0 indicates the slowest forward speed, 9 is the normal speed and 20 is the fastest forward 
speed. 
  
Slider Bar 
Click and drag the bar to move closer to the end or the beginning of the video.  
 
Other functions of the Menu Bar that are not introduced in this section will be described 
here. 
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The <File Path Setting> under the System 
Setting Menu Bar lets the user set the file path. 
 
 
 
You will be able to set the *.avi and snapshot 
paths here. After the path is set, click <Save> to 
save the settings. Note that you can choose the 
snapshot file as *.bmp, *.jpg, *.gif, and *.tif 
formats. The default file type will be in *.bmp 
format. 
 
Under the View Menu Bar, you can choose to 
show/hide the Toolbar, Site Tree, Mode Option, 
and Slider Bar.  
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1. Overview 
The LuxsarRemote CMS (Central Management System) offers a powerful 
interface for a simple and centralized monitoring solution of your video 
surveillance equipments.  
 
It gives the user access to monitor multiple DVRs, and allows the user to 
simultaneously monitor 64 sites per group (up to 10 groups) within several clicks.  
 
 

 
 
Features: 

 Monitor Multiple Sites - Supports up to 10 groups, each group can be added 
up to 64 sites 

 Alert Function (LAN Only) - Sends live/event video clips and messages to 
the local computer from all connected remote DVR(s) 

 Remote Configuration - Configures the settings of the remote DVR(s)  
 Remote Playback – Allows the user to view recorded video stored in the 

remote DVR(s) 
 HDD Information – Displays information of all disk drives that are being 

used on the local computer  
 Remote Playback - Allows the user to view recorded video 
 Dome Control - Remotely operates the speed domes via the Internet  
 Search (Devices) - Searches the network for any available remote DVR 
 Search (Event) - Searches the network for any event recording 
 Record - Records live or playback videos to your local computer (Optional) 
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2. Software Installation 
After getting the installation file, follow the steps below to install the 
LuxsarRemote CMS to the local computer. 
Step 1: Double-click the zipped file to unzip the 

file. 
 
Step 2: After the zip file is opened, click on the 

CMS_Setup_ v*.*.****(version #).exe file to 
start the installation. 

 
NOTE: If a previous version of the LuxsarRemote CMS had been 
installed in the local computer, a message box will show during the 

installation. 

 
 
If you would like to export the previous settings, please click <Cancel> to exit the 
installation. Then, read through the Export or Import Settings section to learn 
about export or import settings. After exporting, re-do the Software Installation to 
install the LuxsarRemote CMS. After clicking <OK> in the message box, a 
wizard window will show. Click <Uninstall> to remove the older LuxsarRemote 
CMS, and continue with the installation steps. When you have finished the 
installation, import the settings to the LuxsarRemote CMS so the 
LuxsarRemote CMS will have the same settings as the previous version of the 
LuxsarRemote CMS. 
If you would like to export the previous settings, please click <Cancel> to exit the 
installation. Then, read through the Export or Import Settings section to learn 
about export or import settings. After exporting, re-do the Software Installation to 
install the LuxsarRemote CMS. After clicking <OK> in the message box, a 
wizard window will show. Click <Uninstall> to remove the older LuxsarRemote 
CMS, and continue with the installation steps. When you have finished the 
installation, import the settings to the LuxsarRemote CMS so the 
LuxsarRemote CMS will have the same settings as the previous version of the 
LuxsarRemote CMS. 
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If you have installed an older version of the LuxsarRemote CMS, after clicking 
<Ok>, an <Uninstall: Confirmation> window will be displayed, click <Uninstall> to 
uninstall the older version and continue with the next step. 
If you have installed an older version of the LuxsarRemote CMS, after clicking 
<Ok>, an <Uninstall: Confirmation> window will be displayed, click <Uninstall> to 
uninstall the older version and continue with the next step. 

 
 
Step 3: Select the components that you want to install. It is strongly 

recommended to select the <Start Menu Shortcuts> to make a 
shortcut to the Start Menu and Desktop, or you have to find the 
program under the path below: “C:\Program Files\CMS\EXE\ 
CMS.exe”. Click <Next> to go to next step. 

 

 
 
The components of the LuxsarRemote CMS Installation Setup: 

: The LuxsarRemote CMS main program (Default). 
: Check to install the LuxsarRemote CMS Player. 
: Check to install the NTP (Network Time Protocol) Service. 

: Check to create shortcuts to the Start Menu. 
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Step 4: The LuxsarRemote CMS main program will be the 1st program to 
install. You can choose a folder to install the LuxsarRemote CMS or 
it will be installed to the default destination folder “C:\Program 
Files\CMS\”. Click <Install> to start the Installation; or click <Back> to 
go back to previous step. 

 
 
Step 5: The LuxsarRemote CMS Player will be the 2nd program to install. 

Click <Next> to go to next step. 
 

 
 
Step 6: Choose a folder to install the LuxsarRemote CMS Player. The 

default destination folder is under “C:\Program Files\CMSPLAYER”. 
Click <Install> to start the Installation; or click <Back> to go back to 
previous step. 
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Step 7: The NTP Service (Server) will be the 3nd program to install. The NTP 

Service (Server) enables the local computer which is running the 
LuxsarRemote CMS to become a central NTP server for the remote 
DVR(s) so the time for the remote DVRs and the local computer is 
synchronized  
Click <OK> to go to next step. 

 

 
 
Step 8: Click <Yes> to start installing the NTP Service (The program is called 

AboutTime MSIE) and continue to complete the NTP Service 
installation. 

 

 

 
Step 9: Click <Close>, and the Software Installation is complete. 
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NTP Service (Server) 
The NTP Service (Server) enables the local computer which is running the 
LuxsarRemote CMS to become a central NTP server for the remote DVR(s) so 
the time for the remote DVRs and the local computer is synchronized.  
 
To do so, you will need to find the IP address of the local computer.  
 
Go to Start menu, select Run. 

 
 
Type in cmd and click OK. 
 

 
 
Type in ipconfig to get the IP Address of your local computer. Write down the IP 
address on a piece of paper for later use. 
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After the IP address is found, enter the <Main Menu> of the remote DVR(s).  
 
First, go to <Main Menu>  <System Setup>  <Time Zone> to enter the time 
zone. Select <Time Zone> to enter the time zone. To find out your local time 
zone, please visit wwp.greenwichmeantime.com 
 

NOTE: The <Time Zone> must be set to your local time zone or the 
<Network Time Protocol Setup> will not be accessible.  

After entering the time zone, the <Network Time Protocol Setup> option will 
appear. Go to <Main Menu>  <System Setup>  <Network Time Protocol 
Setup>, and the following menu will be displayed.  
 

Network Time Protocol Setup 
1. NTP Server 
2. Automatically Time Sync 
3. Manually Time Sync 

time.nist.gov 
1hour 

No 
 
In this example, the NTP server should be set to 192.168.7.122 which is the IP 
address of the local computer. After the time server is set, select <Manually Time 
Sync> to sync the time with the local computer. The time sync can also be 
updated periodically. Select <Automatically Time Sync>, and choose a desired 
time gap to sync the time. 
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3. To Start the LuxsarRemote CMS 
There are 3 ways to start the LuxsarRemote CMS: 
 
Method A: Click Start menu and select Programs; find “CMS” from the listed 

programs and click on it. 

Method B: Double click  shortcut button on your desktop; this is only for 

those who had checked to make the shortcut. Please see section 
<Software Installation> for more information. 

 
Method C: Go to “C:\Program Files\CMS\EXE\” and double click on the 

 button. 

 

4.  Buttons Available on the Main Window 
After starting the LuxsarRemote CMS, the main window of the LuxsarRemote 
CMS will be shown as the figure below. There are several buttons positioned on 
the top of the main window. The name of each button is indicated below. 
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The usage and function of each button will be briefly described in the following 
paragraphs. 
 
Live 
Click on this button to view the live video; the box on the left top corner shows 
the site which you are currently viewing. 
 
Note that after viewing recorded video, you should click this button to switch 
back to live image, otherwise, all grids will show the very last image of the 
recorded video.  
 
PLAY 
Click for viewing recorded video stored in the HDD of remote DVR. Please refer 
to section <To Playback Recorded Video> for more information about playing 
back video. 
PLAYER 
Click to open the LuxsarRemote CMS Player. The LuxsarRemote CMS Player 
is a compact version of the standard DVR Player. 
 
SNAPSHOT 
Click to save a snapshot of current image. Refer to section <To Take a 
Snapshot> for detailed information. 
 
E-MAP 
Click to open the E-MAP program. The E-Map is a program that lets the user 
illustrate the position of the cameras on a self selected image.  
 
RECORD 
This button allows the user to schedule the recording time frame.  
 
SETTING 
Click for assigning camera(s) and setting the site(s)/ group(s). Refer to section 
<Configure Your CMS> for detailed information. 
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Current Viewing Site 
Displays the site that you are currently viewing. If 
the connection to certain camera is failed, then 
there will be no image displayed on its assigned 
grid. Right click on the “site” and a menu will be 
displayed. Click <Connect> and the 
LuxsarRemote CMS will try to reconnect the 
connections to all cameras of the site. 
 
 
 
Bandwidth & Audio 
Click to choose bandwidth options. Choose <High> when the internet speed is 
fast; and <Low> when the network is congested. 
 
Next to the Bandwidth options is the audio button, click to turn on/off the audio. 
 

 

NOTE: Turning the function off or not, audio will be continuously 
recorded to the remote DVR. 

 
Display Modes 
Click any of them to view the image in a multiple 
window mode. You can select from 4-window, 
9-window, 16-window, 25-window, 36-window, 
49-window, and 64-window modes. 
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HDD Info  
The pie chart on the bottom left displays the HDD 
information. This is especially useful when the user 
uses the LuxsarRemote CMS to record the video to 
the local computer.  
 
Scroll down the menu, you can see all the drives that 
are being used on your local computer such as C 
drive, D drive…,etc. The blue color of the pie chart 
indicates the used space, and the yellow color 
indicates the available space. 
 
 
 

5. Configure Your LuxsarRemote CMS 
The LuxsarRemote CMS supports up to 10 groups, and 64 sites can be added 
to each group. For example, you may set 2 groups for daytime recording, and 
the rest for nighttime recording. The following sections guide you to setup your 
LuxsarRemote CMS step by step. 

Click the  button on the top side of the main window, and you will see the 

screen below. 
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5.1 Setup Groups 
Up to 10 groups can be set with the LuxsarRemote CMS. This section guides 
the user to set or remove a group, and also shows the user how to set “start 
group”. 
 
Add a group 

Click  button to add a group. Double click on the group/ site to name it by 

keying the name directly. 
 

 
 
The other way to add a group is right click on <Groups>, and select <Add a 
group>. 
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Set Start Group 
“Start Group” is the group that will be seen on the monitor after starting the 
LuxsarRemote CMS. 
 
Right click on the group you want to set as “start group”, and select <Set as start 
group> from the pull-down menu. 
 

 
 

NOTE: If a group is set as the “start group”, the group icon will be 
changed to mark the difference. 
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Expand/ Collapse a Group 
There are two ways to expand and collapse a group. One way is to use the two 

 buttons; the other is to right click on the group and select <Expand> or 

<Collapse> from the pull-down menu. 
 

 
 
Remove a Group 
To remove a group, click on the group you want to remove, and then click the 

 button directly to remove the chosen one. 
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The other way is to right click <Groups>, now a pull-down menu appears, select 
<Remove all groups> from the pull-down menu. Note that this way is used to 
remove all groups; if you do not want to remove all of them, do not select this 
option. 
 

 
 

5.2 Manage the Site 
This section guides you to structure the groups and sites. 
 

5.2.1 Add/ Remove a Site 
Up to 64 sites can be added to each group. This section guides you to add and 
remove a site. Basically, the procedure is almost the same as that of adding/ 
removing a group. 
 
Add a site 

Choose a group that you want to add a site in. After choosing, click the  

button to add a site to this group. Next section will guide you to setup the site 
step by step. 
 
Double click on the group/ site to name it by keying the name directly.  
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The other way to add a site to certain group is right click on the group, and select 
<Add a site> to add a site. 
 

 
 
Remove a site 

To remove a site, click on the site you want to remove, and then click the  

button directly to remove the chosen one. 
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The other way is to right click on the site, now a pull-down menu appears, select 
<Remove> from the pull-down menu.  
 

 
 
The following section will guide you to setup the site that had been added. 
 

5.2.2 Setup the Site 
A site represents a remote DVR, and that is to say, the number of the site equals 
to the remote DVR. 
 
There are two ways to setup a remote DVR as a “site” on the LuxsarRemote 
CMS. 
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Method A: Set the Site Data Automatically 
The LuxsarRemote CMS is able to search for the IP of the remote DVR(s) that 
had been connected to the LAN. 
 
Step 1: If you have setup a LAN 

network, the LuxsarRemote 
CMS can search the LAN 
network for available remote 
DVR IP addresses. Click the 
Search icon (under the 
Setting Menu) to open the 
Search window. 

 
Step 2: Click <Refresh> to find the IP 

addressed remote DVR(s) in 
your LAN network. Select 
from the listed IP and Double 
click on the IP address to add 
it to a site. 

 
 
 
 

NOTE: The Search function can be used to search for addresses within 
the same LAN. For example, if your local computer uses an IP address 

of 192.168.1.5, and a remote DVR has an IP address of 192.168.1.7, the 
LuxsarRemote CMS will be able to find the IP address of the remote DVR. 
However, if there is another remote DVR connected to another LAN network 
such as 192.168.3.6, the LuxsarRemote CMS (which is 192.168.1.5) will not be 
able to find the IP address.  
 
 
Method B: Set the Site Data Manually 
If you had known the detailed information (IP address, port, user name, and 
password) of the remote DVR(s), you can type in the information manually. 
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Type in a Name for the Site, IP address, Port, Username, and Password. Click 
<OK> to complete the setting. 

 

 
Or if you have the DDNS information of the remote DVR, you can choose to 
enter the DDNS data. Check the box <(D)DNS> circled below, and type in the 
DDNS data. Click <OK> to complete the setting. An example of the DDNS 
address: Example_0040d1.ddns.iview-ddns.com 
 

 

 
NOTE: Port number does not apply to DDNS entries. Therefore, if the 
(D)DNS box had been checked, you do not have to change the default 

port number.  
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5.3  Setup the File Path 
The file path menu enables you to indicate stored destination of snapshot, 
recorded video, and archive files. It is recommended to use the default folders. 
 
The <Circular> function is used to adjust the HDD space usage of the 
LuxsarRemote CMS. For example, when the threshold is set to 1GB, and there 
are 20GB free disk space remaining in the HDD. LuxsarRemote CMS can only 
access the HDD no more than 19GB. As long as the free disk size is smaller 
than threshold, LuxsarRemote CMS will overwrite the earliest recoded data. 

 
 
Snapshot type 
The LuxsarRemote CMS has snapshot function, and you have to set the 
snapshot type here. Note that if you check more than one type, take 2 types for 
example, then you will find each snapshot has been saved into 2 types; exactly 
the same image, but in different types. For instance, if you have selected Bmp & 
Tif and taken the snapshot, you will get two types of image files of the same 
snapshot image. 
 
 
 
 
 
 
 
 
 
 



User’s Manual   

 
22 

5.4  Alert 
The alert function is used for sending alert signals to the LuxsarRemote CMS 
within the LAN network. This section describes how to setup the alert. Follow the 
steps below to setup the alert. 
 
Step 1: Find the IP address of the local computer. 
 

Go to Start menu, select Run. 

 
 

Type in cmd and click OK. 

 
 

Type in ipconfig to get the IP Address of the local computer. Write 
down the IP address on a piece of paper for later use. 
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Step 2: Setup the Alert Notification Setup on the remote DVR. 
This function allows the user to send alert notifications through the 
LuxsarRemote CMS. Enter the menu of the remote DVR and find the 
Alert Notification Setup under <Event Setup>. 

 
 
 
 
 

Alert Configuration Set 
Alert Configuration Set provides 3 combinations of Alert Notification, 
IP, and Port. 
 
Alert Notification 
4 options are included in this item; OFF, Event, Alive, and Both.  
 
<OFF>: The Alert Notification is OFF. 

 
<Event>: When the alarm is triggered, the remote DVR will send an 

alert message to the LuxsarRemote CMS. 
 

<Alive>: The remote DVR will send a message Alive to the 
LuxsarRemote CMS every 2 minutes to show that the 
connections between the remote DVR and LuxsarRemote 
CMS is still in effect.  

 
<Both>: This enables the remote DVR to send both Event and Alive 

alert message to the LuxsarRemote CMS. 
 

Alert IP 
The Alert IP must match the IP address of the local computer. In this 
example, the IP address of the local computer is 192.168.7.122 
 
Alert Port  
The Alert Port is the port used for sending and receiving alert signals. 
Choose any port that is not restricted in your network.  The ports for 
both remote DVR and the LuxsarRemote CMS Alert must be the 
same. In this example, the port is set to 9999. 

 

Alert Notification Setup
1. Alert Configuration Set 1
2. Alert Notification Both
3. Alert IP 192.168.7.122
4. Alert Port 9999
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Step 3: Setup the Alert of the LuxsarRemote CMS. 

Click  positioned on the top of the LuxsarRemote CMS main 

window and go to Alert to setup the port. Port 9999 is used in this 
example. Select ON to enable the alert function and click OK. 

 

 
Step 4: Alert Actions  

The remote DVR sends 4 types of alert message to the 
LuxsarRemote CMS. Alive, Alarm, Motion, and Video Loss. Alive 
messages are sent when you select Alive or Both notification option in 
the remote DVR. Alarm, Motion, and Video Loss messages are sent 
when you select Event and Both notification options in the remote 
DVR. 
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If you open the LuxsarRemote CMS without clicking  to 

connect, and double click on Event Messages (Alarm, Motion Video 
Loss), a message box will be displayed to remind you to connect to 
the site first. 
 
 
 
 
 
 
 
 
 
 
Suppose you have setup the Alert function for a site in Group 1, but you 
have connected to Group 2 or 3.  When you double click on Event 
Messages (Alarm, Motion, or Video Loss), a message box will be displayed 
to inform you that you are currently NOT in the group which sends the alert 
signals to the LuxsarRemote CMS. 
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When you are in group 1, and you have set the Alert function for group 1 
correctly. Double click on the Event Messages (Alarm, Motion, or Video 
Loss), the LuxsarRemote CMS will play the full screen video of the alerted 
channel. 
 

NOTE: The Alert function works ONLY within LAN network. (Please 
refer to the note of the Search function) 

 
 

5.5  Export or Import Settings 
The export/ import function provides the user the option to backup the settings 
when desired.  
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To export the configuration, click <Export>, and select a directory to save the 
*.zip file.  
 
To import the previous configuration, click <Import> and find the *.zip file that you 
previously saved. 
 

NOTE: If you want to install a new version, please remember to export 
the configuration. Otherwise, the configuration of the older version will be 

erased, and you will have to set the configuration again. Please refer to the 
<Software Installation> section. 
 

NOTE: After you restart the LuxsarRemote CMS, the configuration will 
be changed back to your imported setting. 

 

6. Basic Operations 
Following sections show you the basic operation of the LuxsarRemote CMS 
through its Main Window. 
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6.1 To View Live Image/ Assign Camera 
The user can view live video or connect to the remote DVR using the live button. 

Click the  button to view the live display. 

If the connection between the LuxsarRemote CMS 
and the remote DVR has been disconnected, then 
you can reconnect it by right clicking on the Site, and 
select <Live> from the pull-down menu. 
 
 
 
 
The LuxsarRemote CMS enables you to assign any channel from the list to any 
grid of the LuxsarRemote CMS main window. 
 
To assign single channel to certain window 
Step 1: Click and hold the channel you want. 
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Step 2: Drag and drop onto the window that you want to assign in. 

 
 
Step 3: Right click on any channel and select <Refresh> to go back to the 

original viewing mode. 
 

 

 
 
Step 4:  The Live mode goes back to the original setting after refreshing. 
 
To assign all cameras of a site to windows 
Step 1: Click and hold the site you want. 
Step 2: Drag and drop onto the windows. 
Step 3. Right click to refresh the windows. 
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6.2 To Playback Recorded Video 
This function allows the user to remotely play recorded video using the 

LuxsarRemote CMS. Click  button, the figure below will be displayed. 

 
Valid Time indicates that the remote DVR starts recording from a certain period 
of time and ends at a certain period of time. 

 
 
To playback video stored in HDD of the remote DVR 
To play the video stored in the remote DVR, please follow these steps.  
 
Step 1: To play the recorded video from the remote DVR, click <Playback>. 

 

Step 2: Specify the time that you want to view the playback, and click <OK> to 
play the video. 
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The other way to play video is to right click on the wanted group and select 
<Playback> <Remote Playback> from the pull down menu. 

 
 
To save the *.drv files to your local computer 
To save the video to the local computer, please follow these steps. 
 
Step 1: If you want to save the *.drv files to the local PC, click <Archive>. 

 

 
Step 2: Specify the Start Time and End Time and click <OK> to save the DRV 

file to your designated folder. (The default Archive folder is 
“C:\Program Files\CMS\Archive”) 

 
 
Step 3: After the user click <OK>, the LuxsarRemote CMS will <play> the 

archived playback as well. Click  button to go back to the live 

mode. 
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To playback video stored in the HDD of local computer 
There are two ways to playback the video stored in the local computer. Note that 
this is for playing video that are already recorded in the local computer.  
 
You can click <DVR Player> (Under Play window) to run the program, or click 

 on the top of the LuxsarRemote CMS main window. 

 
 
After clicking <DVR Player>, the LuxsarRemote CMS Player, which is a 
compact version of the standard DVR Player, appears, as shown below. 
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Scroll down the File menu or click  to open the 

video files. After clicking either one to play the video, 
select the default folder to play the video. 
 
To convert *.drv files to *.avi files 
The first thing is to go to the “Select a folder”. Scroll down the File menu and 

choose open video file or click , and the “Select a folder” window will pop up. 

On the top right of this window, click <Convert to AVI>. Find the *.drv file that you 
wish to convert to *.avi, and double click it. When you see the “Convert Over” 
message, the conversion process is completed. The file will be stored under 
“C:\Program Files\CMS\Avi” folder.  

  
 
Playing Speed: “0” indicates the slowest forward speed, “9” is the normal speed 
and “20” is the fastest forward speed. 
 

 
 
For more information on the LuxsarRemote CMS Player operations, please 
refer to the <Appendix>.  
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6.3 To Configure the Remote DVR OSD Menu 
The menu contains a list of items that are used to configure the remote DVR. 
 
Right click on the Site and select Configuration to open the OSD menu. 

 
 
The user can setup for each remote DVR that has been added to the 
LuxsarRemote CMS. For instance, to setup Site 1 of Group 1, click on any 
channel of the Site 1 and click the Menu button. To setup Site 2 of Group 1, click 
on any channel of Site 2 and click the <Menu> Button. 
 
The Menu function is similar to the DVRRemote Software. Please refer to the 
DVRRemote User’s Manual for instructions. 
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6.4 To Search the Recorded Video 
The LuxsarRemote CMS is capable of searching 
and playing back recorded video by events. 
 
Right click on the Site and select <Search> and the 
Search Window will be displayed.  
 
 
 
 
 
 
 
 
Double click on any item to view the Event playback. 
 

NOTE: Only those remote DVR(s) in the 
same LAN can be search by the 

LuxsarRemote CMS. The IP address of the LAN can 
be found using the Search button from the Settings.  
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6.5 To Take a Snapshot 

The Snapshot is a simple screen capture tool. When you click the  button, 

it will capture a screenshot of the image that you are currently viewing. You can 
save the screenshots to the default path “C:\ProgramFiles\CMS\Snapshot” or the 
folder that you have previously set in the file path. Please refer to <Setup the File 
Path> for more information about changing file paths. 
 
There are 2 ways to take the snapshot. One is to click <SNAPSHOT>, and the 
Snapshot window will be displayed. Select <OK> to save the file. 

 
 

Taking snapshot using this way captures exactly what you are seeing now on 
the monitor, which means if the LuxsarRemote CMS is currently under 
4-window mode, then you will get a snapshot taken in 4-window mode. 
 
The other ways is to directly right click on the window you want. Note that taking 
through this way will catch the full channel image of the window you click on. 
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For instance, if the LuxsarRemote CMS is under 4-window mode, and you click 
to take a snapshot of channel 3, then you will get a full-window snapshot of 
channel 3 but not a snapshot of 4-window mode. 
 
 
 
 
 
 

 
 

NOTE: When taking snapshots using this method, make sure that you 
have selected at least one of the Snapshot Type (image file format). For 

instance, if you have selected Bmp & Tif and took the snapshot, you will get two 
types of image files of the same snapshot image. 
 
Please go to <Settings> to setup the snapshot type. 
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6.6  Record Function 
While the videos are usually recorded to the remote DVR, the user can choose 
to record live and playback video clips to the local computer as an option.  
 
Right click on the Site and select <Start Record> to 
start recording, and <Stop Record> to stop recording. 
 
 
 
 
 
When the channels are being recorded, the title of the channels will show a 
capital letter “R” ( ). If you have not change the file path, then the recorded 
file will be saved to the default folder “C:\Program Files\CMS\Record” 
 

NOTE: The Record function will save All channels of “a” site. For 
instance, if there are 4 sites connected to the LuxsarRemote CMS and 

the user selects any channel of the 2nd site to record, the LuxsarRemote CMS 
will ONLY record All channels from the 2nd site; and site 1, 3, and 4 will NOT be 
recorded. 
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6.7  Schedule Record Function 
The user can choose the time frame to record the data to the local computer. 

The Schedule Record window will be displayed by clicking  icon on the top 

of the LuxsarRemote CMS main window. 

 
 
The scroll-down menu circled below shows the schedule options. 
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<OFF>: To turn off the schedule record function.  
<Schedule with Event>: To record the scheduled time frame AND all events. 
<Schedule Only>: To record the schedule time frame only.  
<Event Only>: To record event only when the user has set a <Event Only> time 
frame in Schedule Record. 
 
The scroll-down menu circled below shows the cell selection options.  

 
 
<Select Cell>: To manually select cell from the table. 
<Clear Cell>: To manually clear cell from the table. 
<Select All Cell>: To select all cells from the table. 
<Clear All Cell>: to clear all cells from the table. 
 
Here is a step by step explanation on how to set the schedule record for your 
LuxsarRemote CMS. 
 
Step 1: Select a site or a channel from the box on the left by a single click. 

When selecting a site, all channels will apply the same schedule 
setting. You can also set different schedule setting for each channel. 
In this example, we will choose the site. Click the site in box 1, and set 
the schedule option to <Schedule with Event> in box 2. 
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Step 2: Assuming that we want to set the LuxsarRemote CMS to record the 

site from 1:30am to 5am on Tuesday and Wednesday. Click 
1:30~2:00 of Tuesday, and drag to 4:30~5:00 of Wednesday; and the 
color of the cells will be changed to green indicating that these cells 
are to be recorded as <Schedule with Event>. 
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Step 3 After the time frames are selected, click <OK> to save and exit the 

Schedule Record. 
 

 
 

If you want to remove a time frame from the schedule, for instance, 2:30~3:00; 
set the cell selection to <Clear Cell> in box 1. Click and drag 2:30~3:00 from 
Tuesday to Wednesday. The blanked cells indicate that they will not be recorded. 
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Click <OK> to save and exit the Schedule Record. 

 

 
If you want to set the schedule to record at all times, set the cell selection to 
<Select All Cell> or click on the circled blank cell located top left corner of the 
table. If you want to reset the schedule of the site, set the cell selection to <Clear 
All Cell> to do so. Click <OK> to save and exit the Schedule Record. 
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Another way to select or clear time frame is by click on the Day or Time tabs. 
For example, when you click <Tuesday> tab, the color of all Tuesday cells will 
be changed meaning that they will be recorded. When you click 5:00~5:30 tab, 
color of all 5:00~5:30 from Monday to Sunday will be changed. Click <OK> to 
save and exit the Schedule Record. 
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NOTE: The IP camera is not supported in this function. 

 
 

6.8 E-Map Function 
The E-Map is a program that lets the user illustrate the position of the cameras 
on a self selected image. 
 

Click  icon located on the top of the LuxsarRemote CMS main window to 
open the E-Map. The figure below is the main window of the E-Map. 

 
 
Please follow the steps below to setup the E-Map.  
 
Step 1: You will need to load an image file to the E-Map. Click 

<LOADIMAGE> to load the image. 
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Step 2: The figure below is the Load Image window to add, delete, undo, and 
confirm the images. Click <Add> to add the image. Note that the 
E-Map only supports *.bmp, *.jpg, and *.gif files. 
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Step 3: After the image is added, the filename of the image will be displayed 
in the Load Image window. Index indicates the order of the files. If you 
add a 2nd image to the E-Map, the 2nd index will be “1”. After the image 
is loaded, click <Ok> to confirm. 

 

 
Step 4: Select the one of the image files that which are loaded to the E-Map 

from the box circled below.  
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Step 5: The chosen image will be displayed in the E-Map main window. A 
grocery image below is used as an example. Click and hold a channel 
from the box on the left. Drag and drop the channel to any place of the 
image. 

 

 
Step 6: When you point the cursor to the camera icon located in the image, 

an information dialogue box will be displayed as shown in the figure 
below. 
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Step 7: Double click the camera icon in the image to see the live video of the 
camera. 

 
 
There are three camera icon in E-Map, dome, fixed camera, and alert icons. 

 Dome icon.  
 Fixed Camera icon.  
 Alert icon.  

Dome icon will be displayed when the selected camera is a PTZ camera. Fixed 
Camera icon will be displayed when the selected camera is a fixed camera. Alert 
icon will be displayed when the alert is triggered to the camera in the image. 
 
You can adjust the image size displayed on E-Map by clicking the icons circled 
below. 
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<Original>: Displays the original size of the image. 
<Double>: Double the size of the image.  
<Half>: Reduce the image size by half.  
<Fill>: Fill the image to the fit the box (See the figure on the right). 
 
When the image is very large, or when you cannot see the complete image in the 
box on the right, click a channel of the circled box on the left and the E-Map will 
automatically move to the location of the selected channel. 
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Appendix: The LuxsarPlayer 
The LuxsarPlayer is a compact version of the standard DVR Player. The LuxsarPlayer 
main window is shown below with the name of the buttons. 

 
 

The usage and function of each button will be described in the following paragraphs. 
 
Open Video File 
Click to open the video file. The other way to open the video file 
is by clicking the File Menu Bar as shown in the right. 
 
To open a file, you need to find 
the *.DRV files from box 1. After 
the file is found, check <Play 
DRV File> of box 2. Lastly, 
double click the file in box 3, 
and the file will be played 
immediately. If you would like to 
convert the *.drv file to *.avi 
format, click <Convert To AVI> 
next to box 2 instead, and 
double click the file in box 3. 
The default path is:  
“C:\Program Files\CMS\Record” 
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Snapshot 
Click to take a snapshot of the screen. The other way to take the 
snapshot is by clicking the Player Control Menu Bar as shown in 
the right. 
 
 
 
After opening the snapshot window, 
you can choose to rename the 
filename or leave it as it is. Click 
<Ok> to save the snapshot or 
<Cancel> to discard it. 
 
 
 
 
 
Frame View Setting 
This function enables the user to show/hide 
the time/alert text on the video.  
 
Click the <Frame View Setting> icon, and the 
PlayerViewSetting dialogue will be displayed. 
Check <ShowTime, and the time will be 
shown on the screen. Check <Show Frame 
State>, and the alert text such as motion, or 
video loss will be shown. Uncheck to hide 
these texts. 
 
 
 
 
 
The other way to open this function is by 
clicking the System Setting Menu Bar as 
shown in the right. 
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Full Screen 
Click to change the view to full screen mode. 
The other way is by clicking the View Menu Bar 
as shown in the right. 
 
 
About 
Click to view the LuxsarPlayer version 
information. 
 
 
 
 
 
Pause 
Click to pause the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
 
 
 
 
 
Play 
Click to play the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
 
Speed Down 
Click to speed up the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
 
 
 
Speed Up 
Click to speed up the video. The other way is by 
clicking the Player Control Bar as shown in the 
right. 
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Site Tree 
The site tree shows the channels of the remote DVR. Double click a channel to view the 
specified channel in one screen. Note the speaker icon located in the bottom. Click it to 
enable or disable the audio. You can also find it under the System Setting Bar. 
 
The site tree shows the channels of the remote DVR. 
Double click a channel to view the specified channel in one 
screen. Note the speaker icon located in the bottom. Click 
it to enable or disable the audio. You can also find it under 
the System Setting Bar. 
 
 
 
 
 
 
Mode Option 
Click any of them to view the image in a multiple window 
mode. You can select from 4-window, 9-window, and 
16-window 
 
 
Speed Indicator 
0 indicates the slowest forward speed, 9 is the normal speed and 20 is the fastest forward 
speed. 
  
Slider Bar 
Click and drag the bar to move closer to the end or the beginning of the video.  
 
Other functions of the Menu Bar that are not introduced in this section will be described 
here. 
 
The <File Path Setting> under the System 
Setting Menu Bar lets the user set the file path. 
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You will be able to set the *.avi and snapshot 
paths here. After the path is set, click <Save> to 
save the settings. Note that you can choose the 
snapshot file as *.bmp, *.jpg, *.gif, and *.tif 
formats. The default file type will be in *.bmp 
format. 
 
Under the View Menu Bar, you can choose to 
show/hide the Toolbar, Site Tree, Mode Option, 
and Slider Bar.  
 
 
 

 


